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1 Introduction 
This	User	Guide/Method	of	Implementation	(MOI)	provides	information	using	the	GRL-PAM4-
RX	test	solution	to	deliver	automation	control	for	electrical	device	receiver	(Rx)	compliance.	

The	main	body	of	this	documentation	describes	how	to	set	up	the	GRL-PAM4-RX	software	to	
perform	stressed	signal	calibration	and	DUT	compliance	testing	using	existing	PAM4	Host	
Compliance	Boards	(HCB’s)	and	Module	Compliance	Boards	(MCB’s).	

The	test	automation	is	carried	out	based	on	PAM4-approved	MOI’s	with	a	high-performance	
Tektronix	oscilloscope,	Anritsu	BERT,	and	PAM4	combiner	as	the	main	equipment.	As	technical	
reference,	a	manual	test	methodology	that	conforms	to	the	PAM4	Compliance	Test	Specification	
(CTS)	is	also	provided	in	the	Appendix	of	this	documentation.	

The	GRL-PAM4-RX	solution	consists	of	the	GRL	PAM4	receiver	automation	software	which	is	
run	from	the	computer	or	oscilloscope	to	enable	automation	control	to	test	the	device	under	
test	(DUT)	for	Rx	electrical	compliance.	The	GRL	automation	control	enabled	PC	or	scope	
automates	calibration	and	test	sequencing	and	processing	for	signal	tolerances	of	the	DUT	at	
selected	parameters.	The	Rx	path	is	tested	with	worst	case	eye	to	ensure	a	Bit	Error	Ratio	(BER)	
of	less	than	1E-06	can	be	achieved.	When	combined	with	a	satisfactory	level	of	interoperability	
testing,	these	tests	provide	a	reasonable	level	of	confidence	that	the	DUT’s	will	function	
properly	in	most	PAM4	environments. 		

The	documentation	covers	the	following	major	components	for	PAM4	Rx	testing.	

1. GRL-PAM4-RX	automation	software	configuration	and	test	setup.	

2. Manual	CTS	calibration	and	test	procedures	for	Chip-to-module	400Gb/s	eight-lane	
Attachment	Unit	Interface	(CDAUI-8)	for	host	receivers.	

The	MOI	reduces	the	CTS	test	description	to	practice	using	the	specified	test	equipment	and	
procedures	in	an	effort	to	standardize	testing	across	ATCs	and	equipment	manufacturers	who	
perform	their	own	certification	measurements.	
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2 Resource Requirements 
Note: Equipment requirements may vary according to the lab setup and DUT. Below are the 
recommended lists of equipment for the typical test setup.	

2.1 Equipment Requirements 

TABLE	1.	EQUIPMENT	REQUIREMENTS	–	SYSTEMS	 	

System Qty. Description/Key Spec Requirement 

Tektronix	High	Performance	
Oscilloscope	

1	 MSO70000DX	Series	and	above	(recommended)	

≥	33GHz	bandwidth	

DPOJET	Software	

PAM4	Analysis	Software	

Anritsu	BERT		

- Signal	Quality	Analyzer	

	

- Jitter	Modulation	Source	

1	 	

- MP1800A	(28Gbit/s	or	32Gbit/s	Pulse	
Pattern	Generator	Output)	

- MU181500B	

Anritsu	PAM4	Combiner	 1	 MZ1854A	(6dB)	

Wilder	Technologies	PAM4	
Module	Compliance	Board	(MCB)	

1	 QSFP+	100Gb	

(QSFP+	TPA100G-MCB-R	Model)	

Wilder	Technologies	PAM4	Host	
Compliance	Board	(HCB)	

1	 QSFP+	100Gb	

(QSFP+	TPA100G-HCB-P	Model)	

Computer	(laptop	or	desktop)	 1	 For	automation	control	of	the	DUT	

	

TABLE	2.	EQUIPMENT	REQUIREMENTS	–	ACCESSORIES	

Accessory Qty. Description/Key Spec Requirement 

Phase-matched	SMA	Cable	 2	 For	BERT	Data	signals	

≥	33GHz	bandwidth	

SMA	Cable	 1	 For	BERT	Sub-rate	clock	output	

Attenuator	(8dB)	 2	 For	BERT	Data	signals	to	achieve	eye	height	
target	of	<	60mV	

≥	33GHz	bandwidth	
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TABLE	3.	SOFTWARE	REQUIREMENTS	

Software Description/Source 

GRL-PAM4-RX	 Granite	River	Labs	PAM4	Automated	Receiver	Compliance	Test	
Solution	–	www.graniteriverlabs.com	

BERT	Software	 Anritsu	Mainframe	MX180000A	SQA	Control	Software	(Version	
8.00.04	or	above)	
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3 Setting Up GRL-PAM4-RX Automation Software 
This	section	provides	the	procedures	to	start	up	and	pre-configure	the	GRL-PAM4-RX	
automation	software	before	running	tests.	It	also	helps	users	familiarize	themselves	with	the	

basic	operation	of	the	software.	

Note: The GRL software installer will automatically create shortcuts in the Desktop and Start 
Menu when installing the software.  

To	start	using	the	software,	follow	the	procedures	in	the	following	sections.		

3.1 Download Software 

Download	and	install	the	software	as	follows:	

1. Download	the	software	ZIP	file	package	from	the	Granite	River	Labs	support	site.	
2. The	zip	file	contains:	

a) PAM4RxPatternFilesInstallation00xxxxxxxSetup.exe	–	Run	this	on	the	Anritsu	BERT	
to	install	the	pattern	setup	files.	

b) PAM4RxTestApplication00xxxxxxxSetup.exe	–	Run	this	on	the	PC	or	the	Tektronix	
Oscilloscope	to	install	the	application.	

c) PAM4RxTestScopeSetupFilesInstallation00xxxxxxxx.exe	–	Run	this	on	the	Tektronix	
Oscilloscope	to	install	the	scope	setup	files.	

3.2 Launch and Set Up Software 

1. Once	the	software	is	installed,	open	the	GRL	folder	from	the	Windows	Start	menu	and	select	
the	GRL	Framework.	The	GRL	Framework	will	launch.	

	

FIGURE	1.	SELECT	AND	LAUNCH	GRL	FRAMEWORK	
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2. From	the	ApplicationRx	Test	Solution	drop-down	menu,	select	“PAM4	Rx	Test”	to	start	
the	PAM4	Rx	Test	Application.	If	the	selection	is	grayed	out,	it	means	that	your	license	has	
expired.	

	

FIGURE	2.	START	PAM4	RX	TEST	APPLICATION	

3. To	enable	license,	go	to	LicenseLicense	Details.	

	

FIGURE	3.	SEE	LICENSE	DETAILS	

a) Check	the	license	status	for	the	installed	application.	

	

FIGURE	4.	CHECK	LICENSE	FOR	INSTALLED	APPLICATIONS	

b) Activate	a	License:	

 If	you	have	an	Activation	Key,	enter	it	in	the	field	provided	and	select	“Activate”.	

 If	you	do	not	have	an	Activation	Key,	select	“Close”	to	use	a	demo	version	of	the	software	
over	a	free	10-day	trial	period.	
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Note: Once the 10-day trial period ends, you will need to request an Activation Key to continue 
using the software on the same computer or oscilloscope. The demo software is also limited in its 
capability, in that it will only calibrate the maximum frequency for each data rate. Thus, the demo 
version cannot be used to fully calibrate and test a device. For Demo and Beta Customer License 
Keys, please request an Activation Key by contacting support@graniteriverlabs.com. 

4. Select	the	Equipment	Setup	icon	 	on	the	PAM4	Rx	Test	Application	menu.	
5. Connect	the	Anritsu	BERT	via	LAN	to	the	GRL	automation	control	enabled	Scope	or	PC.	
6. On	the	Tektronix	Oscilloscope	or	the	PC,	obtain	the	network	addresses	for	all	the	connected	

instruments	from	the	device	settings.	(Note: The scope IP address can be obtained, if not 
known, by typing CMD → IPCONFIG on the scope and observe the IP address listed.)	

For	example,	the	addresses	may	look	like	the	following	when	the	BERT	is	connected	to	the	
scope:	

 192.168.0.9	(Scope)	

 192.168.0.47:5000	(BERT)	

Note	these	addresses	as	they	will	be	used	to	connect	the	instruments	to	the	GRL	automation	
software.	

7. On	the	Equipment	Setup	page	of	the	GRL	PAM4	Rx	Test	Application,	type	in	the	address	of	
each	connected	instrument	into	the	“Address”	field.		

Then	select	the	“lightning”	button	(							)	for	each	connected	instrument.		

The	“lightning”	button	should	turn	green	(							)	once	the	application	has	successfully	
established	connection	with	each	instrument.	

	

FIGURE	5.	CONNECT	INSTRUMENTS	WITH	GRL	SOFTWARE	
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3.3 Pre-Configure Software before Testing 

Once	all	equipment	is	successfully	connected	from	the	previous	section,	proceed	to	set	up	the	
preliminary	settings	before	going	to	the	advanced	test	setup.	

3.3.1 Enter Test Session Information 

Select									from	the	menu	to	access	the	Session Info	page.	Enter	the	information	as	required	for	
the	test	session	that	is	currently	being	run.	The	information	provided	will	be	included	in	the	
test	report	generated	by	the	software	once	tests	are	completed.	

 The	fields	under	DUT Info and Test Info are	defined	by	the	user.		

 The	Software Info	field	is	automatically	populated	by	the	software.		

	

FIGURE	6.	SESSION	INFO	PAGE	

3.3.2 Set Test Conditions 

Select										from	the	menu	to	access	the	Conditions	page	to	set	the	conditions	for	testing.	The	
software	will	run	tests	for	the	PAM4	data	rate	and	SJ	test	frequencies	that	are	selected.	

a) Data Rate	tab:	PAM4	uses	the	standard	26.5625	GBd/s	data	rate	which	is	pre-selected	
by	default.	

	

FIGURE	7.	DATA	RATE	SETTING	

b) SJ Frequency:	Select	the	desired	SJ	frequencies	for	testing	or	calibration.	

	

FIGURE	8.	SELECT	SJ	FREQUENCIES	 	
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4 Calibrating Using GRL-PAM4-RX 

The	GRL-PAM4-RX	test	solution	supports	automated	Rx	calibration	for	stressed	signals.	The	
GRL	automation	software	typically	runs	a	calibration	sequence	from	the	PC/oscilloscope	for	
stressed	input	followed	by	VEC,	Eye	Height,	and	Eye	Width.	The	typical	calibration	setup	
requires	pattern	generators	on	the	BERT	to	provide	the	necessary	stress	components	as	well	as	
an	oscilloscope,	PAM4	combiner,	and	existing	Host	Compliance	Board	(HCB)/Module	
Compliance	Board	(MCB).	

Prior	to	running	stress	calibration,	the	software	will	first	carry	out	skew	alignments	between	
two	pattern	generators	to	generate	a	PAM4	compliant	test	pattern.	When	completed,	stress	
calibration	will	proceed	without	attaching	a	HCB/MCB	mated	pair.	The	stressed	signal	is	
applied	at	TP4a	(output	of	the	pattern	generator)	and	calibrated	for	initial	values	of	Random	
Jitter	(RJ),	Bounded	Uncorrelated	Jitter	(BUJ),	Total	Jitter	(TJ),	and	Sinusoidal	Jitter	(SJ).	

After	completing	stress	calibration,	the	stressed	signal	will	additionally	be	calibrated	at	TP4	for	
final	Eye	Width,	Eye	Height,	and	VEC	after	attaching	the	HCB/MCB	mated	pair	in	the	setup.	This	
procedure	will	require	obtaining	an	optimal	CTLE	which	generates	the	largest	Eye	Height	and	
Eye	Width.	Proper	adjustments	will	then	be	carried	out	using	this	optimal	CTLE	to	achieve	the	
final	Eye	Height,	Eye	Width,	and	VEC.	

Note: For more details on these calibration, refer to the manual CTS methodology under Appendix 
in Section 10 of this documentation. 
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4.1 Set Up PAM4 Rx Calibration with Automation 

Once	pre-configuration	has	been	completed	from	Section	3.3,	continue	with	the	calibration	
setup.	The	following	procedures	show	how	to	set	up	the	physical	connections	to	perform	
automated	Rx	calibration	for	stressed	signals.	

4.1.1 Connect Equipment for Signal Calibration Without Mated HCB/MCB Pair 

The	connection	diagram	below	shows	the	recommended	equipment	setup	to	perform	skew,	RJ,	
TJ,	and	SJ	calibration	using	a	GRL	automation	control	enabled	scope,	pattern	generators,	and	
PAM4	combiner.	(Note that this calibration is performed before including any mated HCB/MCB 
pair in the setup.)	

	

FIGURE	9.	CONCEPTUAL	PAM4	RX	CALIBRATION	SETUP	DIAGRAM	(WITHOUT	MATED	HCB/MCB	PAIR)	

1. Connect	the	Pattern	Generator	1	(PG1)	and	Pattern	Generator	2	(PG2)	Outputs	from	the	
BERT	to	the	PAM4	Combiner.	

2. Connect	the	Data+	Output	from	the	PAM4	Combiner	to	Channel	1	of	the	Scope.	
3. Connect	the	Data-	Output	from	the	PAM4	Combiner	to	Channel	3	of	the	Scope.	
4. Connect	the	Sub-rate	Clock+	Output	from	the	BERT	to	Channel	2	of	the	Scope.	
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4.1.2 Connect Equipment for Signal Calibration with Mated HCB/MCB Pair 

The	connection	diagram	below	shows	the	recommended	equipment	setup	to	perform	VEC,	Eye	
Width,	and	Eye	Height	calibration	using	a	GRL	automation	control	enabled	scope,	pattern	
generators,	PAM4	combiner,	and	mated	100G	HCB/MCB	pair.	

	

FIGURE	10.	CONCEPTUAL	PAM4	RX	CALIBRATION	SETUP	DIAGRAM	(WITH	MATED	HCB/MCB	PAIR)	

1. Connect	the	Pattern	Generator	1	(PG1)	and	Pattern	Generator	2	(PG2)	Outputs	from	the	
BERT	to	the	PAM4	Combiner.	

2. Attach	the	100G	Host	Compliance	Board	(HCB)	to	the	100G	Module	Compliance	Board	
(MCB).	

3. Connect	the	Data+	Output	from	the	PAM4	Combiner	to	a	8dB	attenuator	to	TX1+	on	the	HCB	
side	of	the	mated	100G	HCB/MCB	pair.	

4. Connect	the	Data-	Output	from	the	PAM4	Combiner	to	a	8dB	attenuator	to	TX1-	on	the	HCB	
side	of	the	mated	100G	HCB/MCB	pair.	

5. Connect	the	TX1+	Output	on	the	MCB	side	of	the	mated	100G	HCB/MCB	pair	to	Channel	1	of	
the	Scope.	

6. Connect	the	TX1-	Output	on	the	MCB	side	of	the	mated	100G	HCB/MCB	pair	to	Channel	3	of	
the	Scope.	
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5 Testing Using GRL-PAM4-RX 
The	GRL-PAM4-RX	test	solution	supports	automated	Rx	compliance	testing	for	PAM4	Host	
DUT’s.	After	completing	calibration,	the	GRL	automation	software	will	perform	testing	for	
stressed	input	compliance	of	the	Host	DUT.		

To	create	the	typical	test	environment,	the	oscilloscope	is	first	disconnected	from	the	mated	
100G	HCB/MCB	pair	in	the	previous	calibration	setup.	The	MCB	is	then	removed	from	the	
mated	HCB/MCB	pair	to	allow	the	DUT	to	be	connected	to	the	HCB.	When	setup	is	ready,	testing	
will	proceed	and	a	detailed	test	report	will	be	generated	once	test	is	completed.	

5.1 Set Up PAM4 Rx Test with Automation for Host DUT 

Once	calibration	has	been	completed	from	Section	4,	continue	with	the	following	setup	to	
perform	Rx	stressed	input	compliance	testing	for	the	Host	DUT.	

	

FIGURE	11.	CONCEPTUAL	PAM4	RX	HOST	DUT	TEST	SETUP	DIAGRAM	

1. From	the	previous	calibration	setup	in	Section	4.1.2,	disconnect	the	oscilloscope	from	the	
mated	100G	HCB/MCB	pair.	

2. Unplug	the	MCB	from	the	mated	100G	HCB/MCB	pair.	
3. Connect	the	HCB	to	the	Host	DUT.	

	



GRL Confidential	 	 Pulse-Amplitude Modulation 4 (PAM4)	

GRL-PAM4-RX	User	Guide/MOI	 Rev.	1.0			

© Granite River Labs 2017 Page	19	of	49	

6 Configuring and Selecting Calibration and Tests Using 
GRL-PAM4-RX 

6.1 Set Up Calibration/Test Requirements 

After	setting	up	the	physical	equipment,	select									from	the	GRL	PAM4	Rx	Test	Application	
menu	to	access	the	Setup	Configuration	page.		

Enter	the	target	Eye	Width	and	Eye	Height	values	to	be	applied	during	final	stage	calibration.	

	
FIGURE	12.	SET	UP	EYE	PARAMETERS	

6.2 Select Calibration and Tests 

Select										from	the	menu	to	access	the	Select Tests	page	which	displays	all	available	Rx	
compliance	calibration	and	tests.	User	must	make	sure	to	run	and	complete	calibration	first	
before	proceeding	with	DUT	testing.	If	calibration	is	not	completed,	running	the	DUT	test	will	
show	an	error	message.		

	

FIGURE	13.	SELECT	TESTS	PAGE	

6.2.1 Select Initial Stressed Signal Calibration  

Under	“Signal	Calibration	before	Mated	HCB/MCB	Pair”,	select	to	perform	skew	adjustments	
between	dual	pattern	generators	and	stress	calibration	before	applying	the	HCB/MCB	mated	
pair.	The	stressed	signal	will	be	calibrated	for	initial	values	of	Random	Jitter	(RJ),	Total	Jitter	
(TJ),	and	Sinusoidal	Jitter	(SJ).	

	

FIGURE	14.	SELECT	INITIAL	STRESS	CALIBRATION	
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6.2.2 Select Final Stressed Signal Calibration  

Under	“Signal	Calibration	after	Mated	HCB/MCB	Pair”,	select	to	perform	calibration	for	optimal	
CTLE	and	final	Eye	Height,	Eye	Width,	and	VEC	using	the	optimal	calibrated	CTLE	value	after	
applying	the	HCB/MCB	mated	pair.	

	

FIGURE	15.	SELECT	FINAL	STRESS	CALIBRATION	

6.2.3 Select DUT Rx Compliance Test  

After	completing	calibration,	under	“Receiver	Tests”,	select	to	perform	the	Rx	stressed	input	
compliance	test	for	the	Host	DUT.	

	

FIGURE	16.	SELECT	HOST	DUT	RX	TEST	

	

6.3 Configure Calibration and Test Parameters 

After	selecting	the	desired	calibration/test,	select									from	the	menu	to	access	the	
Configurations	page.	Set	the	necessary	parameters	for	calibration	and	testing	as	described	
below.	

	

FIGURE	17.	TEST	PARAMETERS	CONFIGURATION	PAGE	

TABLE	4.	TEST	PARAMETERS	DESCRIPTION	

Parameter Description 

Signal Source Select	the	scope	channels	that	are	connected	to	the	Data	outputs	
of	the	PAM4	combiner.		

Trigger Source Select	the	scope	channel	that	is	connected	to	the	Sub-rate	Clock+	
Output	of	the	BERT.	
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BT4 Filter Bandwidth 
(GHz) 

Set	the	frequency	for	the	electrical	bandwidth	of	the	fourth-order	
Bessel-Thomson	(BT4)	filter	used	with	the	reference	receiver.	
For	PAM4	signals,	the	bandwidth	is	generally	set	to	a	frequency	
of	50%	of	the	data	rate.	

PLL Bandwidth (MHz) Set	the	frequency	for	the	Phase	Locked	Loop	(PLL)	bandwidth	of	
the	reference	receiver.	The	recovered	clock	will	make	use	of	the	
configured	PLL	bandwidth	to	reduce	frequency	effects	in	the	
stressed	signal	calibration.		

CTLE (dB) Select	the	CTLE	of	the	reference	receiver	to	obtain	the	optimal	
CTLE	which	generates	the	largest	Eye	Height	and	Eye	Width.	

	

6.4 Configure Calibration Target Values 

For	debugging	purposes	ONLY,	the	default	calibration	target	values	can	be	changed	for	the	RJ	or	

TJ	calibration.	To	do	this,	select										from	the	menu	to	access	the	Calibration	page.	

By	default,	the	calibration	target	values	are	those	defined	in	the	specification.	To	change	the	
values,	un-select	the	Use	Default	Value	checkbox.	In	case	the	default	values	are	required	again,	
just	select	the	checkbox	to	allow	all	existing	values	to	be	reset	to	default.	

Note: The PID Control setting is used to adjust the step width for steps calculation if the target 
measurement cannot be met with the current step. To adjust, use a lower PID Control value to 
reduce the subsequent step or increase the control value to make the subsequent step bigger. 

	

FIGURE	18.	CALIBRATION	TARGET	OVERWRITE	PAGE	
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7 Running Automation Calibration and Tests Using GRL-
PAM4-RX 

Once	selected	calibration	and	tests	are	ready	to	be	run,	select									from	the	GRL	PAM4	Rx	Test	
Application	menu	to	access	the	Run	Tests	page.	

Under	“Run	Option”,	select	the	option	to	either:	

 Skip Test if Result Exists	‒	If	results	from	previous	calibration/tests	exist,	the	software	
will	skip	those	calibration/tests,	or	

 Replace if Result Exists	‒	If	results	from	previous	calibration/tests	exist,	the	software	
will	replace	those	calibration/tests	with	new	results.	

	

FIGURE	19.	RUN	TESTS	PAGE	

Select	the	Run Tests	button	to	automatically	start	running	the	selected	calibration	and	tests.	At	
the	start	of	a	specific	calibration/test,	the	corresponding	connection	diagram	will	initially	
appear	to	allow	the	user	to	verify	with	the	recommended	physical	setup	before	continuing	with	
the	next	step.	Below	shows	an	example	of	a	connection	diagram	pop-up	window.	

	

FIGURE	20.	CONNECTION	DIAGRAM	POP-UP	WINDOW	EXAMPLE	 	



GRL Confidential	 	 Pulse-Amplitude Modulation 4 (PAM4)	

GRL-PAM4-RX	User	Guide/MOI	 Rev.	1.0			

© Granite River Labs 2017 Page	23	of	49	

8 Interpreting GRL-PAM4-RX Test Report 
When	all	calibration	and	test	runs	have	completed	from	the	previous	section,	the	GRL-PAM4-RX	
software	will	automatically	display	the	results	on	the	Report page.		

Select								from	the	menu	to	access	the	Report	page	for	a	quick	view	of	all	results.		

If	some	of	the	results	are	not	desired,	they	can	be	individually	deleted	by	selecting	the	Delete	
button.		

For	detailed	test	report,	select	the	Generate report	button	to	generate	a	PDF	report.	To	have	
the	calibration	data	plotted	in	the	report,	select	the	Plot Calibration Data	checkbox.	

	

FIGURE	21.	TEST	REPORT	PAGE	

8.1 Understand Test Report Information 

This	section	gives	a	general	overview	of	the	test	report	to	help	users	familiarize	themselves	
with	the	format.	Select	the	Generate report	button	to	generate	the	test	report.	

8.1.1 Test Session Information 

This	portion	displays	the	information	previously	entered	on	the	Session Info	page.	

	

FIGURE	22.	TEST	SESSION	INFORMATION	EXAMPLE	
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8.1.2 Test Summary Table 

This	table	provides	an	overall	view	of	all	the	calibration	and	tests	performed	along	with	their	
conditions	and	results.	

	

FIGURE	23.	TEST	SUMMARY	TABLE	EXAMPLE	

8.1.3 Test Results  

This	portion	displays	the	results	in	detail	along	with	supporting	data	points	and	screenshots	for	
each	calibration/test	run.	
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FIGURE	24.	TEST	RESULTS	EXAMPLE	

	

8.2 Delete Test Results 

To	individually	delete	any	unwanted	calibration/test	results,	select	the	corresponding	result	
row	and	Delete	button.	

To	entirely	remove	all	existing	calibration/test	results,	select	the	Delete All	button.	

	

FIGURE	25.	DELETE	TEST	RESULTS	
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9 Saving and Loading GRL-PAM4-RX Test Sessions 
The	usage	model	for	the	GRL-PAM4-TX	software	is	that	the	test	results	are	created	and	
maintained	as	a	‘Live	Session’	in	the	application.	This	allows	the	user	to	quit	the	application	and	
return	later	to	continue	where	the	user	left	off.			

Save	and	Load	Sessions	are	used	to	save	a	test	session	that	the	user	may	want	to	recall	later.	
The	user	can	‘switch’	between	different	sessions	by	saving	and	loading	them	when	needed.		

 To	save a test session,	with	all	of	the	test	parameter	information,	test	results,	and	any	
waveforms,	select	the	Options	drop-down	menu	and	then	select	“Save	Session”.	

 To	load	a test session	back	into	the	application,	including	the	saved	test	parameter	settings,	
select	Options		“Load	Session”.	

 To	create a new test session	and	return	the	application	back	to	the	default	configuration,	
select	Options		“New	Session”.	

	

FIGURE	26.	SAVE/LOAD/CREATE	TEST	SESSIONS	

The	test	configuration	and	session	results	are	saved	in	a	file	with	the	‘.ses’	extension,	which	is	a	
compressed	zip-style	file,	containing	a	variety	of	information.	
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10 Appendix A: Manual CTS Procedure for PAM4 Receiver 
Measurements 

This	section	describes	the	methodology	to	perform	PAM4	receiver	measurements	per	the	PAM4	
PHY	CTS	requirements.  	

The	following	procedure	gives	a	typical	example	on	how	to	measure	the	stressed	impairments	
for	the	PAM4	receiver.	

i) Set	up	equipment	without	the	Host	Compliance	Board	(HCB)/Module	Compliance	Board	
(MCB).			

ii) Perform	skew	alignments	between	the	Pulse	Pattern	Generator	1	and	2	(hereafter	referred	
to	as	PG1	and	PG2).	The	electrical	length	of	the	dual	pattern	generators	should	be	matched.	

iii) Calibrate	stresses	before	applying	the	HCB/MCB	mated	pair.	At	TP4a,	the	Pattern	
Generator	will	be	calibrated	for	initial	values	of	Random	Jitter	(RJ),	Bounded	Uncorrelated	
Jitter	(BUJ),	Total	Jitter	(TJ),	and	Sinusoidal	Jitter	(SJ).		

iv) Insert	the	HCB/MCB	mated	pair.	
v) Determine	the	optimal	CTLE.	Multiple	CTLEs	will	be	applied	to	the	Reference	Receiver	to	

determine	the	optimal	CTLE	which	generates	the	largest	Eye	Height	and	Eye	Width.	
vi) Adjust	for	final	Eye	Height,	Eye	Width,	and	VEC	using	the	optimal	CTLE.	

10.1.1 Initial Equipment Setup 

The	following	figure	shows	the	initial	setup	without	connecting	the	HCB/MCB	mated	pair	
(direct	connection).	(Note that this setup is using the Anritsu BERT.)	

	

FIGURE	27.	PHYSICAL	SETUP	BEFORE	CONNECTING	HCB/MCB	
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 Connect	the	PAM4	Combiner	directly	to	the	PG1	and	PG2	Differential	Outputs	of	the	BERT.	
 Connect	the	DATA+	Output	of	the	PAM4	Combiner	to	CH1	of	the	Oscilloscope	and	the	DATA-	

Output	to	CH3	(or	CH2	and	CH4	respectively,	depending	on	the	selected	setup).	
 Connect	the	Sub-rate	Clock+	of	the	BERT	to	the	CH2	Clock	Input	(or	the	selected	channel)	of	

the	Scope.	(Note: This will be used as the Trigger for PG1 and PG2 skew adjustment.)	
 Enable	the	dual	Pattern	Generators	of	the	BERT	in	Combination	Mode.	In	Combination	

Mode,	configure	the	PG1	and	PG2	to	generate	the	PAM4	signal:		

a) On	the	BERT’s	Pattern	Generator	page,	select	the	“Misc2”	tab.	
b) Select	the	“Setting…”	button	and	select	Combination	under	‘Operation’.	

	

FIGURE	28.	ENABLE	BERT	PATTERN	GENERATOR	IN	COMBINATION	MODE	
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10.1.2 PG1 and PG2 Skew Adjustment  

To	generate	the	PAM4	pattern,	ensure	that	the	electrical	path	lengths	of	PG1	and	PG2	are	as	
closely	matched	as	possible,	by	performing	delay	line	adjustments	for	both	pattern	generators.	
This	will	be	done	by	measuring,	adjusting,	and	matching	Eye	Diagram	crossing	locations	for	
PG1	and	PG2.	The	measurements	on	the	Scope,	in	Equivalent	Time	Mode,	will	be	referenced	to	
the	same	clock	which	will	be	injected	on	CH2	of	the	scope.	

 On	the	BERT’s	Jitter	Modulation	Source	page,	turn	ON	all	stresses	(SJ,	RJ,	BUJ).	

a) Set	0%	for	all	enabled	stresses.	
b) Set	the	Sub-rate	Clock	to	‘1/80’.	

	

FIGURE	29.	ENABLE	ALL	STRESSES	

 On	the	BERT’s	Pattern	Generator	page,	select	the	“Output”	tab	and	set	the	Data	Rate	to	
26.5625Gbps.	Also	set	Amplitude	to:	

a) 1.2Vpp	on	Data1.			
b) 0.6Vpp	on	Data2.		

	Note: A 2:1 ratio should be maintained to obtain appropriate PAM4 amplitudes. 
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FIGURE	30.	SET	DATA	RATE	AND	DATA1	AND	2	AMPLITUDES	

 Turn OFF	Data1	by	setting	“Data/XData”	to	OFF.	

	

	



GRL Confidential	 	 Pulse-Amplitude Modulation 4 (PAM4)	

GRL-PAM4-RX	User	Guide/MOI	 Rev.	1.0			

© Granite River Labs 2017 Page	31	of	49	

 On	the	Scope:	

a) Set	Trigger	Source	[Trig > A Event (Main) trigger setup > Ch2]:	CH2	

	

FIGURE	31.	SET	TRIGGER	SOURCE	

b) Set	Math	[Math > Select Ch1-Ch3]:	

 Math1	Position:	0div	

 Scale:	100mV	

	

FIGURE	32.	SET	MATH	
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c) Set	Sampling	Mode	[Horiz/Acq tab > Sampling Modes > Equivalent Time]:	Equivalent	

	

FIGURE	33.	SET	SAMPLING	MODE	

d) Set	Variable	Display	Persistence	[Display tab > Display Persistence > Persistence Controls]:	

 Select	“Variable”	

 Persist	Time:	100s	

	

FIGURE	34.	SET	VARIABLE	DISPLAY	PERSISTENCE	
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e) Set	Horizontal	Acquisition	[Horiz/Acq tab > Horizontal Acquisition Setup]:	

 Sample	Rate:	10T/s	

 Mode:	Manual	

 Record	Length:	1000	

	
FIGURE	35.	SET	HORIZONTAL	ACQUISITION	

 Apply	Cursors	[Cursors tab]:	

 Check	“Cursors On”	

 Cursor	Type:	V Bars	

	
FIGURE	36.	ENABLE	CURSORS		
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 Drag	Cursor	“a”	to	the	center	crossing	on	the	DATA2	Eye	Diagram.	

	
FIGURE	37.	ADJUST	CURSOR		

 Turn ON DATA1	and	turn OFF DATA2.			
 Using	the	Delay	function	on	DATA2,	adjust	the	delay	until	the	DATA2	crossing	matches	the	

Marker	location	for	the	DATA1	crossing.	

	
FIGURE	38.	ADJUST	DATA2	DELAY		

 Now	re-enable DATA1.	Both	DATA	Outputs	should	now	be	enabled.		
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 Verify	that	the	generated	Eye	is	a	PAM4	Eye	Diagram.	

	

FIGURE	39.	VERIFY	EYE	DIAGRAM	

10.1.3 Stress Calibration Before Attaching HCB/MCB Mated Pair 

The	following	diagram	shows	an	example	of	the	stressed	input	calibration/test	setup	for	the	
host	under	test.	The	stressed	signal	is	applied	at	TP4a	(output	of	BERT)	and	will	additionally	be	
calibrated	at	TP4	(after	attaching	the	HCB/MCB	mated	pair).	

	

FIGURE	40.	HOST	STRESSED	INPUT	CONNECTION	SETUP	
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This	section	describes	the	calibration	for	the	Pattern	Generator	Jitter	characteristics	at	the	
output	of	the	pattern	generator	(TP4a).	

 Using	the	same	physical	setup	from	Figure	27,	calibrate	the	pattern	generator	(BERT)	
output	at	TP4a.	

a) On	the	BERT,	change	the	pattern	to	the	PAM4	Clock	Pattern	JP03A.	

i) Select	PPG	>	Pattern	>	Test	Pattern	>	Data.	
ii) Select	“Edit”	to	change	DATA	pattern.	
iii) Select	File	>	Open	>	Pattern	Files	>	PAM	Pattern.	
iv) Under	Directories,	select	“JP03A”.		
v) Under	File List,	select	“JPO3A.txt”.	

	

FIGURE	41.	CHANGE	PATTERN	ON	BERT	

b) On	the	Scope,	set	Jitter	Measurements	with	Clock	Pattern.	

i) Open	DPOJET.	
ii) Select	Analyze	>	Jitter	and	Eye	Analysis(DPOJET)	>	Select:	

 TJ@BER	
 RJ-DD1	
 DCD1	

	

FIGURE	42.	SELECT	JITTER	MEASUREMENTS	ON	SCOPE	
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iii) Select	the	“Configure”	button	followed	by:	

 Edges:	

o Make	sure	all	Measurements	use	“Data”	as	the	Signal	Type.	

	

FIGURE	43.	SELECT	DATA	SIGNAL	TYPE	ON	SCOPE	

 RjDj:	

o Set	Target	BER	to	“1E-06”.	

o Click	“Apply	to	All”.	

	

FIGURE	44.	SET	TARGET	BER	ON	SCOPE	
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 Clock	Recovery:	

o Set	Method	to	“Constant	Clock	–	Mean”.	

	

FIGURE	45.	SET	CLOCK	RECOVERY	METHOD	ON	SCOPE	

iv) Select	the	“Plots”	button	and	select	the	“Eye	Diagram”	plot.	

	

FIGURE	46.	SELECT	EYE	DIAGRAM	PLOT	ON	SCOPE	
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v) Configure	Acquisition	(Horiz/Acq > Horizontal Acquisition Setup).	

 Set	Mode	to	“Manual”.	

 Set	Bandwidth	to	“33GHz”.	

 Set	Sample	Rate	to	“200GS/s”.	

 Set	Record	Length	to	“5M”.	

c) Enable	and	calibrate	RJ.	

i) On	the	BERT,	go	to	the	jitter	Setting	page	and	set	the	initial	RJ	to	“0.096	UIp-p”.	

	

FIGURE	47.	SET	INITIAL	RJ	ON	BERT	

ii) On	the	Scope,	measure	RJ	to	the	target	value	of	0.15UIp-p	at	BER	1E-06.		
iii) On	the	BERT,	adjust	RJ	until	the	target	value	is	met.	

d) Enable	and	calibrate	TJ.	

i) On	the	BERT,	go	to	the	jitter	Setting	page	and	enable	BUJ	with	the	following	settings:	

 PRBS:	“PRBS7”	

 Amplitude:	“0.100UIp-p”	

 Bitrate:	“2.65Gbps”	

 LPF:	“200MHz”	

	

FIGURE	48.	SET	UP	BUJ	ON	BERT	
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ii) On	the	Scope,	measure	TJ	to	the	target	value	of	0.28UIp-p	at	BER	1E-06.	
iii) On	the	BERT,	adjust	BUJ	until	the	target	TJ	value	is	met.	

e) Enable	and	calibrate	SJ.	

i) On	the	BERT,	go	to	the	jitter	Setting	page.	Enable	SJ	and	disable	RJ	and	BUJ.	
ii) For	each	case	in	the	table	below:	

 Set	the	SJ	frequency	and	amplitude	to	the	values	defined.	

 Measure	the	SJ	amplitude	on	the	Scope	to	the	target	value.	

 Adjust	the	SJ	amplitude	on	the	BERT	until	the	target	SJ	value	is	met.	

	

FIGURE	49.	SET	UP	SJ	ON	BERT	

10.1.4 VEC, Eye Height and Eye Width Calibration After Attaching HCB/MCB Mated Pair 

The	Eye	Height	and	Eye	Width	will	be	measured	to	a	probability	of	10E-6	at	TP4.	This	is	
performed	by	adjusting	the	RJ	and	Output	Amplitude	of	the	pattern	generator	(while	making	
sure	not	to	exceed	900mVpp	at	the	output	of	the	pattern	generator)	to	meet	the	target	Eye	
Height	and	Eye	Width.	This	can	be	done	by	setting	the	CTLE	of	the	Reference	Receiver	to	obtain	
the	optimal	CTLE	which	generates	the	largest	Eye	Height	and	Eye	Width.	Using	this	optimal	
CTLE,	proper	adjustments	will	then	be	carried	out	to	achieve	the	final	Eye	Height,	Eye	Width,	
and	VEC.	

	

FIGURE	50.	VEC,	EYE	HEIGHT	AND	EYE	WIDTH	CONNECTION	SETUP	
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 Set	up	the	equipment	as	shown	in	the	following	diagram.	Both	the	Host	Compliance	Board	
(HCB)	and	Module	Compliance	Board	(MCB)	are	included	in	the	setup	to	perform	final	Eye	
Width,	Eye	Height,	and	VEC	measurements.	(Note: The current 100G test fixture has four 
differential TX ports and four differential RX ports. All paths should be the same, but TX1 is 
used as the default path in this setup.)	

	

FIGURE	51.	PHYSICAL	SETUP	WITH	HCB/MCB	ATTACHED	

 Connect	the	PAM4	Combiner	directly	to	the	PG1	and	PG2	Differential	Outputs	of	the	BERT.	
 Connect	the	DATA+	and	DATA-	Outputs	of	the	Combiner	to	8dB	attenuators	to	TX1+	and	

TX1-	of	the	HCB	side	of	the	mated	100G	HCB-MCB	respectively.	(Note: Use the 8dB 
attenuators to enable the BERT Data signals to achieve eye height target of < 60mV.)	

 Connect	the	TX1+	and	TX1-	Outputs	of	the	MCB	side	of	the	mated	100G	HCB-MCB	to	CH1	
and	CH3	or	CH2	and	CH4	of	the	Scope	respectively.	

 Set	up	the	Scope	as	follows:	

a) Set	Math	to	“Ch1-Ch3”	[Math > Math Setup].		(Note: Ch1 and Ch3 should be scaled 
appropriately.)	
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FIGURE	52.	SET	MATH	

b) Set	Bandwidth	to	“33GHz”	[Vertical > Vertical Setup].	This	applies	to	All	channels.	

	

FIGURE	53.	SET	BANDWIDTH	
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c) Set	Sample	Rate	[Horiz/Acq > Horizontal/Acquisition Setup]	as	follows:	

 Mode:	“Manual”	

 Sample	Rate:	“200GS/s”	

 Record	Length:	“20M”	

	

FIGURE	54.	SET	SAMPLE	RATE	

 Open	and	set	up	the	Tektronix	PAM4	Analysis	Tool	as	follows:	

a) Select	Analyze	>	PAM4	Analysis.	
b) Select	the	“Config”	button	and	configure	the	following:	

i) Under	Main Setup:	 	

 Symbol	Rate:	“26.5625GBd”	

 Waveform	Source:	“Math	1”	

ii) Under	Clock Recovery:	

Clock	Recovery	is	set	for	First-Order,	20dB/decade	roll-off	with	JTF	BW	at	10MHz.	

 PLL	Model:	“Type	1”	

 JTF	BW	(MHz):	“10MHz”	

iii) Under	CTLE:	

 Enable	CTLE	(select	the	CTLE	check	box)	

 CTLE	Presets:	“OIF-CEI	GEN	I”			
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iv) Select	Bessel-Thomson (BT) Filter:	

 Enable	BT	Filter.	

 Set	to	Manual	Bandwidth	Mode.		

 Set	BW:	“33GHz”			

c) Select	the	“Prefs”	button	and	configure Population Control:	 	

 Limit	Method:	“Number	of	Symbols”	

 Number	of	Symbols:	“4000000”	

 Determine	the	CTLE	which	maximizes	product	of	Eye	Height	and	Eye	Width	as	follows:	

a) Set	CTLE	to	1dB.	
b) Select	the	“Run”	function	on	the	Tektronix	PAM4	Analysis	Tool.		

(Note: Make sure to select the “Run” mode and not “Single”, in order for the application to 
run continuously for several minutes to capture the required number of waveforms for 
10E-06 analysis.) 

c) Select	the	“Full	Wfm”	button	and	capture	the	following:	

i) Eye	Height	EH6		
ii) Eye	Width	EW6	
iii) VEC	

	

FIGURE	55.	CAPTURE	EYE	MEASUREMENTS	



GRL Confidential	 	 Pulse-Amplitude Modulation 4 (PAM4)	

GRL-PAM4-RX	User	Guide/MOI	 Rev.	1.0			

© Granite River Labs 2017 Page	45	of	49	

d) Populate	the	EH6,	EW6,	and	VEC	measured	values	in	the	following	table.	Calculate	the	
Area.	(Note: Typically 3 or 4 CTLE’s will need to be measured to find the CTLE with the largest 
area.)	

 Target: 5.3 to 6.3dB Target: 0.20UI or 14.96ps Target: 40mV  

CTLE VEC (dB) EYE WIDTH (UI) EYE HEIGHT (mV) AREA (EH6 x EW6) 

1	 	 	 	 0	

2	 6.262	 0.21	 29.48	 6.1908	

3	 	 	 	 0	

4	 	 	 	 0	

5	 	 	 	 0	

6	 	 	 	 0	

7	 	 	 	 0	

8	 	 	 	 0	

9	 	 	 	 0	

e) Repeat	steps	a	to	d	with	additional	CTLE’s	(2	to	9dB)	and	enter	the	EH6,	EW6,	and	VEC	
values	in	the	table.	

f) Determine	the	optimal	CTLE	that	generates	the	largest	area.	This	CTLE	will	be	used	for	
final	measurement.	

 Perform	final	adjustments	for	the	RJ	and	pattern	generator	Output	Amplitude	(without	
exceeding	900mVpp)	with	the	largest	area	CTLE.	These	should	be	adjusted	to	reach	the	
target	EH6,	EW6,	and	VEC	values	in	the	specifications	using	the	reference	receiver	with	the	
setup	of	the	optimal	CTLE	that	was	determined	in	the	previous	step.	

	

FIGURE	56.	FINAL	ADJUSTMENTS	FOR	RJ	AND	PG	OUTPUT	AMPLITUDE	
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Note: Ensure to maintain the 2:1 ratio between the DATA1 and DATA2 output amplitudes of the 
pattern generator for proper PAM4 signaling. 

a) On	the	PAM4	Analysis	Tool,	set	CTLE Presets	to	“OIF-CEI	Type	I”	(Optimal	CTLE).	
b) On	the	BERT	Jitter	Modulation	Source	page,	configure	the	following:	

i) Turn	on	Sinusoidal	Jitter	(SJ)	at	100	MHz.		
ii) Set	the	SJ	frequency	to	0.04MHz	as	defined	in	the	following	table.	

	

iii) Set	the	SJ	amplitude	to	the	previously	calibrated	value.	

	

FIGURE	57.	SET	UP	SJ	ON	BERT	

iv) Adjust	RJ	by	increasing	or	decreasing	the	RJ	until	the	target	values	of	Eye	Height,	Eye	
Width,	and	VEC	are	met.	
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FIGURE	58.	ADJUST	RJ	ON	BERT	

c) On	the	BERT	PPG	page,	adjust	the	DATA1/DATA2	Amplitude.	

Note: Ensure to maintain the 2:1 ratio between the DATA1 and DATA2 output amplitudes of the 
pattern generator for proper PAM4 signaling. 

	

FIGURE	59.	ADJUST	DATA	OUTPUT	AMPLITUDE	ON	BERT	
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d) Measure	EH6,	EW6,	and	VEC	and	verify	that	their	target	values	are	met,	as	follows:	

i) On	the	PAM4	Analysis	Tool,	select	the	“Run”	function.	

	

FIGURE	60.	MEASURE	EH6,	EW6,	AND	VEC	

ii) If	the	target	values	are	met,	the	measurement	is	completed	successfully.	Otherwise	
repeat	step	b	(iv)	onwards	to	adjust	the	RJ	and	output	amplitude.	
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10.1.5 Equipment Setup for DUT Testing 

The	following	figure	shows	the	typical	connection	setup	for	testing	the	Host	DUT.	

	

FIGURE	61.	PHYSICAL	TEST	SETUP	FOR	HOST	DUT		

 Connect	the	PAM4	Combiner	directly	to	the	PG1	and	PG2	Differential	Outputs	of	the	BERT.	
 Connect	the	DATA+	and	DATA-	Outputs	of	the	Combiner	to	8dB	attenuators	to	TX1+	and	

TX1-	of	the	HCB	respectively.	
 Connect	the	HCB	to	the	Host	DUT.	
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